ArcGIS® Data Interoperability Tutorial
Contents

Getting started.....................................................................................................................................................v
  Making sure Data Interoperability is visible in ArcCatalog .................................................................................. 5
  Enabling the ArcGIS Data Interoperability extension ........................................................................................... 5
  Adding the Data Interoperability Tools to ArcToolbox ........................................................................................... 5

Chapter 1 Performing a direct read of interoperability data ............................................................................... 1
  In this chapter .................................................................................................................................................. 1
  Objective ......................................................................................................................................................... 1
  Using the ArcCatalog tree ................................................................................................................................... 2
  Using the Interoperability Connections node .......................................................................................................... 4
  Interoperability in ArcMap .................................................................................................................................. 9

Chapter 2 Translating data using Quick Import and Quick Export .................................................................... 13
  In this chapter .................................................................................................................................................13
  Objective ........................................................................................................................................................13
  Adding Quick Import and Quick Export tools to ArcToolbox ..................................................................................14
  Performing Quick Import ...................................................................................................................................15
  Performing Quick Export ....................................................................................................................................17
  Using Quick Import and Quick Export in ModelBuilder ............................................................................................19

Chapter 3 Transforming data using Custom Import and Custom Export.......................................................... 26
  In this chapter ..................................................................................................................................................26
  Objective .........................................................................................................................................................26
Using Custom Import ................................................................................................................................. 27
  Creating the Custom Import tool .................................................................................................................. 27
  Modifying the Custom Import tool ............................................................................................................... 32
  Saving the Custom Import tool as a Custom Format .................................................................................. 37
  Associating a format with a file extension .................................................................................................. 38
Using Custom Export ..................................................................................................................................... 40
  Creating the Custom Export tool ................................................................................................................ 40
  Modifying the Custom Export tool ............................................................................................................. 44

Appendix A  Getting started with Workbench .............................................................................................. 48
  Workbench interface .................................................................................................................................. 48
  Menu bar and toolbar ................................................................................................................................. 48
  Tools for managing the layout .................................................................................................................... 49
  Tools for enhancing the canvas ............................................................................................................... 49
  Status bar .................................................................................................................................................. 50
  Workbench elements .................................................................................................................................. 50
  Color definitions ........................................................................................................................................ 50
  Quick changes ......................................................................................................................................... 51
  Inserting transformer connections ................................................................................................ .......... 51
  Inserting vertices on links ........................................................................................................................ 52
  Log ............................................................................................................................................................ 52
  Viewing Log Files ...................................................................................................................................... 52
To enable the ESRI® ArcGIS® Data Interoperability extension, you may have to perform one or more of the following steps from within ArcGIS:

**Making sure Data Interoperability is visible in ArcCatalog**

1. From the ArcCatalog™ Tools menu, click Options.
2. Click the General tab.
3. Under Which top level entries do you want the Catalog to contain, check the Interoperability Connections check box.
4. Under Which types of data do you want the Catalog to show, check the Interoperability Data check box.

**Enabling the ArcGIS Data Interoperability extension**

1. From the ArcCatalog Tools menu, click Extensions.
2. Check the Data Interoperability check box.

**Adding the Data Interoperability Tools to ArcToolbox**

1. Open the ArcToolbox™ window.
2. Right-click the ArcToolbox name and click Add Toolbox.
3. Browse to the Toolboxes folder.
4. Click the System Toolboxes folder and choose Data Interoperability Tools.
Chapter 1: Performing a direct read of interoperability data

In this chapter
- Using the ArcCatalog tree
- Using the Interoperability Connections node
- Interoperability in the ArcMap™ environment

Objective
You have received data in a variety of formats and you would like to familiarize yourself with the data.
Using the ArcCatalog tree

In this exercise, you will use the tree to see how the Data Interoperability extension enables new formats to be easily viewed within ArcCatalog.

1. Start ArcCatalog and browse the files in the folder
   \ArcTutor\Data_Interoperability\Tutorial Data

2. Click flood_plains.mif.

3. Click the Preview tab to see the data.

When viewing a dataset for the first time, the Data Interoperability extension will create a cache.

Note that many other interoperability formats can be viewed in the same way.

Unlike ESRI formats, many other formats allow multiple geometries per dataset. When you first load a dataset, all possible geometries are shown. Once a dataset has been cached, the Data Interoperability extension can determine which feature classes are populated.

4. Refresh the parent folder to prune empty feature classes.

To do this, click the Tutorial Data folder and press F5 or right-click and click Refresh. The layers for the MapInfo (MIF) files collapse. Expand flood_plains.mif and note that only populated feature classes are now listed.

5. Switch to Table preview mode to see the attributes for the feature class.

6. Switch back to Geography preview mode.
7. Use the Identify tool to selectively view feature attributes.

8. Click the Metadata tab and click the Description, Spatial, and Attribute tabs to access the metadata for the feature class.

You have now completed the exercise 'Using the ArcCatalog tree'.
Using the Interoperability Connections node

While you can simply browse to many formats in ArcCatalog, some formats may require that you specify additional information (such as a username and password) before you can view the data, and other formats may not be identifiable via their filename extension. The Interoperability Connections node provides a way to fully specify both a format and all of its required settings, so that you can directly work with its data.

In this exercise, you will use the Interoperability Connections node to view Intergraph® Modular Geographic Information System (GIS) Environment (MGE) files. The MGE format is based on MicroStation® Design, with nongraphical elements defined through links to a database.

Follow the steps below to add a new Interoperability Connection in ArcCatalog for the MGE dataset found in the Parcels folder.

1. Under the Interoperability Connections node, double-click Add Interoperability Connection.

   This opens the Interoperability Connection dialog box.

   ![Interoperability Connection dialog box](image)

2. Set the Source Format to Intergraph MGE and set the Source Dataset to parcels/parcel_K24.par.

   ![Setting Interoperability Connection](image)
3. Click the Settings button. The MGE Input Settings dialog box appears.

To specify the Access database that contains the MGE attributes, click Access MDB as the Database Type, and browse to parcel_attrs.mdb in the parcels folder.

4. Click OK to close the dialog box.

5. Click the Coordinate System button in the Interoperability Connection dialog box to open the Spatial Reference Properties dialog box.

This dialog box may be empty, or the last used Coordinate System may have already been preselected.
6. Click the Select button, navigate to Projected Coordinate Systems\State Plane\NAD 1983 (feet), and click the NAD 1983 StatePlane Texas Central FIPS 4203 (Feet).prj projection.

7. Click the Add button to return to the Spatial Reference Properties dialog box, which is now populated.
The Interoperability Connection dialog box now lists the coordinate system name.

9. Click OK. ArcCatalog loads the data. The new connection will be listed under Interoperability Connections and will be named something similar to Connection (1) – parcel_K24 MGE. Rename it as parcels_K24.

10. Preview the LOT_LINES Line feature class to trigger the data source indexing.

11. After indexing is complete, refresh the data source so that only the populated feature classes are listed.

8. Click OK to return to the Interoperability Connection dialog box.

Chapter 1: Performing a direct read of interoperability data
12. Preview the LOT_LINES Line feature class, and use the Identify tool to click a line. Observe the new MGE attributes.

You have now completed the exercise ‘Using the Interoperability Connections node’.

In the next exercise, you will examine how interoperability data acts within the ArcMap environment.
Interoperability in ArcMap

Follow the steps below to open the Parcels MGE data source in ArcMap. (Note that if the extension is not yet enabled in ArcMap, you must enable it.)

1. Launch ArcMap, then drag and drop the parcels_K24 interoperability connection into the Layers pane of ArcMap. By dragging the entire node, all feature classes in the connection will be added.

You will see the LOT_POINTS and LOT_LINES feature classes.

2. Now, from ArcCatalog, browse to subdivisions.tab and drag the Subdivisions polygon feature class into ArcMap. Do the same for flood_plains.mif by browsing to the file in ArcCatalog, then dragging the Polygon feature class into ArcMap.

3. Modify the layer properties of the subdivisions to enable MapTips and display subdivisions color-coded by the date_added attribute.

Right-click the subdivisions Polygon layer and click Properties. Click the Fields tab and ensure that the subdivision_name field is the Primary Display Field.
4. Click the Display tab and check the Show MapTips box.

5. Click the Symbology tab, then click Categories, and click Unique values. Change the Value Field to date_added. Then, by clicking the Add All Values button, you will have added a legend item for each individual date that a subdivision was added to the survey.

6. Click OK in the dialog boxes, and observe the new symbology. Hover over the subdivisions to see the names displayed in MapTips.
7. Search for Gaston Park and zoom in on it. Click on the Selection menu and choose Select By Attributes. Set the Layer to subdivisions Polygon. Double-click the subdivision_name field, click Like, then type ‘GAS%’ in the text box so the query will select Gaston Park using a wildcard search.

8. Click Apply, then click Close.

Observe that the Gaston Park subdivision is selected.
9. Click the Selection menu and click Zoom To Selected Features. Use the Zoom tool to zoom close to the Gaston Park subdivision so it is easily visible.

As you can see, interoperability data behaves exactly as native data in ArcMap.

You have now completed the exercise ‘Interoperability in ArcMap’.

In the next chapter, you will use the Quick Import functionality to import data into the ArcGIS environment.
Translating data using Quick Import and Quick Export

In this chapter

- Adding Quick Import and Quick Export tools to ArcToolbox
- Performing Quick Import
- Performing Quick Export
- Using Quick Import and Quick Export in ModelBuilder

Objective

In the previous exercises, you used the direct read capabilities of ArcGIS Data Interoperability in which you directly read foreign file formats. In this chapter, you will use the Quick Import functionality to import data into the ArcGIS environment. This is useful in situations in which you want to bring data into your system or if you need to edit data from a foreign system. Whereas direct read worked directly with the original data, Quick Import creates a copy of the original data in ArcGIS.

You will then use Quick Export to quickly and easily export data from ArcGIS to any of the supported formats. Taken together, Quick Import and Quick Export enable ArcGIS to be used as a central geoprocessing hub, regardless of format.

For this activity, you will first import zoning data from Geography Markup Language (GML) into ArcGIS. You will then use Quick Export in the same way to export the data (to native MapInfo® TAB) to familiarize yourself with the ease at which Quick Export works. Finally, you will use Quick Import and Quick Export within ModelBuilder™ to perform a Dissolve operation to dissolve and aggregate polygons by zoning type, removing the tiling within the original GML dataset. The resulting data will then be exported to GML and MapInfo TAB.
**Adding Quick Import and Quick Export tools to ArcToolbox**

The Quick Import and Quick Export tools are located within the Data Interoperability Tools toolbox. To use them, you must first add the toolbox to ArcToolbox:

1. Open the ArcToolbox window in ArcCatalog by clicking the Toolbox icon on the toolbar:

   ![ArcToolbox window](image1)

   You will see the ArcToolbox window as shown below:

   ![ArcToolbox window](image2)

   To add a new toolbox, right-click ArcToolbox (highlighted above) and click Add Toolbox.

2. Browse to the System Toolboxes folder under Catalog/Toolboxes, click Data Interoperability Tools, and click Open.

   ![Add Toolbox](image3)

   You have added the Data Interoperability Tools toolbox to ArcToolbox, and you are ready to use Quick Import and Quick Export.
Performing Quick Import

1. To perform Quick Import on the zoning GML data, double-click the Quick Import tool within the Data Interoperability Tools toolbox.

For this exercise, you want to import zoning.gml into a personal geodatabase called zoning.mdb. The input data is located in the Tutorial Data\zoning folder.

2. Click the Browse button shown above to display the dialog box below. This is where you will specify the input file format and the location of the zoning.gml dataset.

**Tip:** When you specify the input dataset, the tool will, in many cases, read the file extension and automatically fill in the format. You will still need to verify that the correct format was filled in, since in some cases, a file extension is associated with multiple formats.

3. When you have filled in both the Source Format and Dataset fields, click OK to close the dialog box.
4. Specify the output staging geodatabase as \ArcTutor\Data_Interoperability\Tutorial Data\zoning\zoning.mdb.

5. From the Quick Import window, click OK to perform the import operation.

While the import operation is being performed, a progress window will display information on the progress of the import process, along with statistics of the number of features imported and the processing time.

The window (shown below) will stay displayed until you explicitly close it.

6. You can now view the zoning geodatabase to see the imported data in ArcCatalog.
You have successfully performed a Quick Import on the GML data.

Next you will use this imported GML data to perform a Quick Export from the geodatabase you created above to native MapInfo TAB format.

Performing Quick Export

1. To perform Quick Export on the zoning data, double-click the Quick Export tool within the Data Interoperability Tools toolbox.

2. The Quick Export dialog box appears. From the Input Layer field, browse to the zoning feature class from the geodatabase created in the previous exercise. Click Add.
3. Click the Browse button in the Quick Export dialog box Output Dataset field.

4. This will display the Specify Output Data Destination dialog box. Specify the Format as MapInfo TAB. Set the Dataset to the Tutorial Data\zoning folder.

5. The Quick Export window should now appear as follows. Click OK to perform the export operation. The window displays information on the progress of the import process, along with statistics of the number of features imported and the processing time. The window (shown below) will remain displayed until you explicitly close it.
You have successfully used Quick Export to export data from ArcGIS.

This is useful for sharing data with users who don’t have the capability to directly read ArcGIS data. Now you should use ArcCatalog to browse to the directory and see the zoning data in native MapInfo TAB format.

**Using Quick Import and Quick Export in ModelBuilder**

This exercise demonstrates how to use Quick Import and Quick Export within the ArcGIS geoprocessing environment. Among other things, this shows how ArcGIS can be used as a geoprocessing environment even if the data is not stored within ArcGIS.

You will be using Quick Import to import the data into ModelBuilder, dissolve the polygons of the zones, and export the data to GML and MapInfo TAB.

1. First you need to create your own model. To do this, you must create a user toolbox in which to place the model. Right-click the ArcToolbox root node and click New Toolbox. This creates a new toolbox named “Toolbox”, as shown below.
2. Right-click Toolbox and click Rename. Rename the toolbox “QuickImportExportTutorial”, as shown below.

3. Create a new model by right-clicking the toolbox you created and clicking New > Model. This will result in an empty model within ModelBuilder, as shown below:

4. Drag the Dissolve tool (located in the Data Management toolbox under the Generalization set of tools) onto the model. The result is shown in the model window below.
5. Drag the Quick Import tool from the Data Interoperability toolbox. Drag the Select Data tool from Data Management Tools > General toolbox. The ModelBuilder window should look like this:

6. Double click the Quick Import tool and click the Browse button beside the Input Dataset field. The Specify Input Data Source dialog box appears.

7. Select the GML Version 2.x Source Format, and \ArcTutor\Data_Interoperability\Tutorial Data\zoning\zoning.gml as the source dataset. Click OK to close the Specify Input Data Source dialog box. The Quick Import dialog box has been automatically populated.

8. Click the OK button to close the dialog box. The ModelBuilder window will look like this:
9. Click the Add Connection tool and drag the connector from zoning2.mdb to Select Data.

10. Click the Add Connection tool, and drag the connector from Output Data to Dissolve.

The result is shown in the ModelBuilder window below:

11. Right-click Dissolve and click Open. Since you want to dissolve only by the type attribute, check the type box under Dissolve_Field(s).

Specify the Output Feature Class as \ArcTutor\Data_Interoperability\Tutorial Data\zoning\zoning_Dissolve.shp.

12. Click the OK button to close the Dissolve window.
The result is shown in the ModelBuilder window below.

13. Click the Model menu and choose Run Entire Model. The Model status window appears and displays a processing log. When processing is complete, click Close to dismiss the window.


Notice the effects of the Dissolve operation on the data. In the original data, there were tiles overlaid; with the dissolve, the tiles are gone. Take a look at the original data to review the effects of the Dissolve operation.

15. To export the data back to GML and MapInfo TAB, drag and drop two Quick Export tools onto the ModelBuilder window.
16. Rename the tools. Right-click Quick Export, click Rename, and type Quick Export GML. Right-click Quick Export (2), click Rename, and type Quick Export MapInfo.

17. Click the Add Connection tool and drag the connector from zoning_dissolve.shp to Quick Export GML.

18. Click the Add Connection tool and drag the connector from zoning_dissolve.shp to Quick Export MapInfo.

The ModelBuilder window should now look like this:

19. Set the output data destination for GML. Double-click the Quick Export GML tool, and then click the Browse button in the Output Dataset field.

20. The Specify Output Data Destination dialog box appears. Choose GML Version 2.x as the format, and zoning_output.gml as the dataset. Click OK to close the dialog box.

21. Click OK to close the Quick Export GML window.
22. Set the output data destination for MapInfo TAB. Double-click the Quick Export MapInfo tool, and then click the Browse button in the Output Dataset field. Choose MapInfo TAB as the format. Click the Browse button in the dataset field and browse to the zoning folder. Click Open.

23. Click OK to close the Specify Output Data Destination dialog box.

24. Click OK to close the Quick Export MapInfo window.

25. Run the model and view the output MapInfo TAB file, zoning_Dissolve.tab, and the GML file, zoning_output.gml, shown below.

At the beginning of this chapter, you learned how to use Quick Import and Quick Export to facilitate data sharing. In the latter part of this chapter, you used ArcGIS Data Interoperability to enhance the geoprocessing capabilities of ArcGIS by integrating data from other systems directly into a geoprocessing model.

You have now completed the exercise ‘Translating Data Using Quick Import and Quick Export’.
Chapter 3

Transforming data using Custom Import and Custom Export

In this chapter
- Using Custom Import
- Using Custom Export

Objective
You can use ArcGIS Data Interoperability to quickly and efficiently perform sophisticated manipulations to data as it is being moved into or out of ArcGIS. The Workbench application provides a graphical environment for modeling geometry and schema transformations, which become Custom Import and Custom Export tools.

In this exercise, you will use Workbench to set up a Custom Import and a Custom Export that manipulate their input data to create output that exactly matches your requirements.

You've received the first of many data files in Intergraph MGE. The data is tiled and contains no polygonal topology. You would like to have a convenient way to view or import the data while transforming it into something more meaningful.
Using Custom Import

In this exercise, you will use the ArcCatalog browse tree to see how the Data Interoperability extension enables new formats to be easily viewed within ArcCatalog.

If the ArcToolbox pane is not visible from within ArcCatalog, add it by clicking the Show/Hide ArcToolbox button.

Creating the Custom Import tool

   2. Rename the new toolbox “Import Tools”. Right-click the Import Tools toolbox and click New > Custom Data Import Tool.
   3. In the Create Custom Import Tool wizard that appears, click Next.

Chapter 3: Translating data using Quick Import and Quick Export
4. When prompted to Select Source Format, click the Browse button to display the Formats Gallery, and double-click Intergraph MGE.

5. When prompted to Locate Sample Source Data, click the Add Source Datasets button.

6. This will display a dialog box that allows you to select multiple files and folders. Click the Add Dir button to browse to the folder \ArcTutor\Data_Interoperability\Tutorial Data\parcels, and then click Open.

7. In our example, the MGE files do not have the standard .dgn extension; instead, they have a .par extension. Double-click .dgn in the File/Filter column to display the Edit File/Filter dialog box. Change the file extension to *.par.

8. Click OK to close the dialog box and return to the Locate Sample Source Data window.
9. Click the Settings button to display the MGE Input Settings dialog box. From here, you can pick which database holds the MGE attributes.

10. In the Database Type field, choose Access MDB. In the Access MDB File field, browse to \ArcTutor\Data_Interoperability\Tutorial Data \parcels\parcelsattrs.mdb. In this case, the default settings in the remaining fields are acceptable.

11. Click OK to close the dialog box and return to the Locate Sample Source Data window.

12. Click Next, and click Finish to end the wizard. After all the data has been read, Workbench will start.

**Note:** For more information on Workbench, see Appendix A or view the Data Interoperability Help files from within ArcGIS.

13. Select and delete all the nodes as shown in the red boxes in the screen below:
14. Only these destination features should remain: LOT_LINES_LINE and LOT_POINTS_POINT.

15. Click File > Exit in Workbench and save the new custom tool.

16. From the ArcToolbox Import Tools menu, right-click the Custom Data Import Tool and click Rename.

17. Name the tool Import MGE Parcels.
18. Double-click MGE Import Parcels to display the Import MGE Parcels window. Accept the default location that appears in the Output Staging Geodatabase field.

**Note:** By hovering the cursor over the default Original Design File text box, you can see from the ToolTip that all .par files in the parcels folder will be read.

19. Click OK to run the tool. The Import MGE status window displays the processing log. When processing is complete, click Close.

20. You can examine the resulting geodatabase in ArcCatalog to view the results. You will see that it contains the lines and points from all .par files contained in the parcels directory, as well as the attributes from the Access database.

You have now completed the exercise ‘Creating the Custom Import tool’.

In the next exercise, you will use Workbench to create polygons from the MGE LOT_LINES data, then add attributes to the polygons from LOT_POINTS.
Modifying the Custom Import tool

1. Edit the tool, Import MGE Parcels, that you created in the previous exercise. Right-click the tool and click Edit. This will launch Workbench.

Once Workbench is open, you can begin to modify the tool. First, you will add a transformer. Transformers are the geoprocessing building blocks of Workbench used to manipulate features.

2. To add the transformer, click the Gallery tab in the bottom, left pane; type “areabuilder” in the search box; and click the Find button.

3. When the results are displayed, double-click or drag the AreaBuilder transformer onto the main Workbench window (canvas).

4. Click the line connecting the GeometryFilter and the LOT_LINES destination feature type and press Delete. This will disconnect the LOT_LINES destination feature from the GeometryFilter. Connect the GeometryFilter to the AreaBuilder by clicking the yellow arrow beside the LINE attribute and dragging the arrow to the AreaBuilder INPUT. The AreaBuilder INPUT arrow turns green.

5. Select and delete the connector to the LOT_POINTS destination feature.

6. Use the Transformer Gallery to find and add a PointOnAreaOverlayer. This transformer will allow you to add attributes to the LOT_LINES areas.

7. Connect the GeometryFilter POINT Point output to the PointOnAreaOverlayer POINT input, and the
AreaBuilder AREA output to the PointOnAreaOverlayer AREA input.

**Tip:** Right-click a connector line and click Insert Vertex on Link. This adds vertices so you can route arrows around your work flow.

8. To do this, search the Transformer Gallery for a Tester transformer, and add the transformer to your work flow.

9. From the PointOnAreaOverlayer, connect the AREA output to the Tester input. To specify the test, click the properties button on the Tester transformer.

   **Note:** The properties button displays an exclamation point because one of the underlying fields is blank. You will have to edit the dialog box.

10. In the Tester Properties dialog box, type `overlaps` in the left Value field, and 1 in the right Value field.

The PointOnAreaOverlayer creates attributes for each polygon based on the point it contains. It also creates an Overlaps attribute that is useful for validating data. If the Overlaps attribute for a polygon is greater than 1, there are multiple points inside that polygon. If the Overlaps value is 0, there are no points for that polygon. In this case, you want to test the Overlaps value, and if it’s not equal to 1, you will output these features as error_polygons.
11. Click OK to close the dialog box. Notice that the Properties button has now changed to an ellipsis, indicating that you have edited the Properties.

12. Click the Properties button of the LOT_LINES destination feature. Change the Feature type name to Problem_polys, and change the Allowed geometries to geodb_polygon. Now the geometry is correct and the output features can accept the new attributes.

13. Click the User Attributes tab, select all the attribute names (using Ctrl + left-click, or Shift + left-click), then click Delete. This will remove all the attributes from your destination feature. These are old line attributes, and they no longer apply to your new polygon features.

14. Click OK to close the dialog box.

15. Click the Properties button of the LOT_POINTS destination feature. Change the Feature type name to parcels, and change the Allowed geometries to geodb_polygon. However, do not delete all the attributes, since they are the attributes originally from the points, and you want to save them on your parcels.

16. Click OK to close the dialog box.

17. Connect the PASSED output from the TESTER to the parcels destination feature, and the FAILED output to the Problem_polys destination feature.

18. Expand the parcels destination feature.
19. Since the Interactive Graphic Design Software (IGDS) format attributes that were originally in the MGE file are now meaningless, you can delete them. Right-click igds_class on the parcels destination feature, and click Delete Attribute.

20. Repeat this for all attributes starting with igds.

21. Click the Properties button on the Problem_polys destination feature and click the User Attributes tab.

22. In the Attribute Name column, type `num_points`. Change the data type to integer. This will add a new attribute to capture the number of points that overlapped the Problem_poly.

23. Click OK to close the dialog box.
At this point, you will notice that the arrow going into the num_points attribute is red. This means that Workbench could not find an attribute in the Tester that matched that name. To populate this attribute with the values from Overlaps, you must manually connect them.

24. Left-click on the Tester FAILED overlaps yellow output port, and drag the line across to the num_points red input port. Both ports will turn green.

25. From the Workbench Tools menu, click Route to Visualizer. This will give you an idea of what the data will look like when you run this tool.
26. Click the Workbench Run button to preview the data.

27. Close the Visualizer.

28. Click File > Save to save your work in Workbench, but leave the Workbench window open for the next part of this exercise.

You have created a custom import tool that will read MGE data, create polygons from the lines, and overlay the points on the area’s merging attributes. This tool can be run by itself, as in the first exercise, or used in a geoprocessing model.

### Saving the Custom Import tool as a Custom Format

Sometimes it is useful to apply the geometry and schema transformations of a Custom Import tool to data without actually importing it into ArcGIS. In this way, you don’t make a copy of the data, but you view the original data directly after you have applied the transformations. To do this, you can save your Custom Import tool as a Custom Format.

1. Choose File > Export as Custom Format:
2. Enter *Custom_Parcels* as a new custom format name, and *Custom Parcels* as a description, and click OK to close the dialog box.

3. You will now have two open Workbench windows: one window shows the Custom Data Import tool and the other window shows the Custom Format. Click File > Exit to close both Workbench windows.

Now that you have successfully created your Custom Format, you can access it from the Interoperability Connections node.

### Associating a format with a file extension

If you want your Custom Format to be accessible from the ArcCatalog browse tree, you can associate it with a specific file extension.

1. Double click Add Interoperability Connections, then click the Browse button.

This displays the Workbench Formats Gallery.
2. Select Custom Parcels, then click the Edit button. Workbench will start up and display the Custom Parcels format.

3. Expand the parcels node in the left navigation pane.

4. Right-click on Original Design File (in the left navigation pane) and click Edit Parameter Prompt.

5. The file type filter indicates the file extension that this format should be associated with, and consists of a description and filter, separated by a | character. Delete the existing file type filter, and type

   Parcel_Files(*.par)|*.par

   Under Associate Format with Filter, choose Yes. This tells ArcCatalog to automatically browse files with a .par extension.

6. Click OK to close the dialog box, and then save and exit Workbench.

7. Click OK to close the Formats Gallery.

8. Click Cancel in the Interoperability Connections dialog box (since you were using it just to access the Formats Gallery).
9. Restart ArcCatalog so that it can refresh its file type mappings. When you browse in the catalog tree to files with a .par extension, they will be automatically read via your newly created custom format.

You have now completed the exercise ‘Associating a format with a file extension’.

In the next exercise, you will be exporting bird information stored in the personal geodatabase to AutoCAD. The nests in the resulting AutoCAD® files will be represented as symbols (blocks), where the specific symbol type is set depending on the cover type that was observed for each nest. In addition, the block rotation must be set correctly to reflect the observed nest direction.

Using Custom Export

Creating the Custom Export tool


2. Rename the new toolbox "Export Tools". Right-click the Export Tools toolbox and click New > Custom Data Import Tool.

This will bring up a wizard where you must select layers to use as input to the tool. These layers will be used as a template for building the tool; when the tool is run later, any layer or layers can be used as input to the tool.

3. Click Next.
4. Click Add Feature Classes and browse to the \ArcTutor\Data_Interoperability\Tutorial Data\birds_eggs\nests.mdb file.

5. Double-click the NESTS table to be used as the source layer.

Workbench will open, showing a default mapping of the NESTS table to the NESTS layer in AutoCAD.

9. Expand the source and destination types.

6. Click Next.

7. For the destination format, choose AutoCAD DWG/DXF.

8. Click Next until the wizard closes, accepting the defaults.

Chapter 3: Translating data using Quick Import and Quick Export
10. Add a ValueMapper to the tool and connect it between the source and destination features. This will map the different nest cover types to different AutoCAD symbols.

11. Edit the ValueMapper properties.

12. In the Edit ValueMapper Transformer dialog box, select the COVER Source attribute. This is the attribute from the geodatabase features that will determine the mapping.

13. You must also define how the values for this attribute map to the block types. Fill in the dialog box fields as shown below. The default value is defined in case any values are not matched. Note that all entries are case-sensitive.

14. Click OK to close the dialog box. The block_name attribute will be added to the output of the
ValueMapper; this attribute will contain the mapped value.

Next, you’re going to expose the autocad_block_name, autocad_entity, and autocad_rotation attributes on the destination feature type. These attributes are used to tell the writer how to write the blocks in the output file.

15. Edit the properties for the output feature type, and in the Format Attributes tab, check the boxes beside autocad_block_name, autocad_entity, and autocad_rotation attributes as shown:

16. Click OK to close the dialog box.

17. Double-click the red port beside autocad_entity and replace New Constant with autocad_insert.

18. Connect the block_name attribute to the autocad_block_name attribute and the ROTATION attribute to the autocad_rotation attribute as shown:

Each nest feature will be represented by the proper symbol, rotated in the proper direction.
19. In the navigation tree on the left, click the Workspace tab and expand the DWG output parameters. Right-click the Template File parameter and click Always Prompt. When you run the tool, you will be prompted for the template file.

20. Double-click the Template File parameter to change the default value. Browse to birds_eggs\template.dwg (which contains all the blocks referenced earlier in the ValueMapper).

21. Click OK.

22. Save your work and exit Workbench.

23. You can now run the tool can on its own from ArcToolbox or include it in a ModelBuilder model. To run the tool, double-click it in ArcToolbox and fill in the required parameters, and then use ArcCatalog to examine the resulting AutoCAD file.

**Modifying the Custom Export tool**

In this part of the exercise, you will modify the Custom Export tool you created in the previous exercise to also write out a GML file containing the nest data.

1. Right-click on the Custom Export tool you created, and click Edit. Workbench starts up.

2. From the Workbench Destination Data menu, click Add Dataset. Select GML Version 2.x as the Format, and type output.gml as the dataset:

3. Click OK.

4. Answer No when asked if you want to add a new feature type to the dataset. Instead of making your own feature type from scratch, you will make a copy of the one used in the AutoCAD output.
5. Right-click the AutoCAD output feature type NESTS and click Duplicate. Connect the new output feature type to the ValueMapper output as shown:

6. Edit the properties for the new feature type. Under the General tab, change the Dataset value to GML_2, and set the Allowed geometries to gml2_point, as shown. Each GML2 feature type can only hold a single geometry, so you must specify it here.

If you were to run the tool right now, you would get a single output .gml file with a single feature type (NESTS_2) containing all the nest features.

It would be more useful if the GML file contained a separate feature type for each nest cover type. You could add new output feature types for each possible cover type (giving you feature types such as WILLOW, BARE, and ROCK), but that would not scale well when the possible cover types change.
Instead, you can use the Feature Type Fanout to instruct Workbench to dynamically make new output feature types based on the value of an attribute.

7. Check the Fanout feature type check box, and choose the COVER attribute to fan out, as shown:

8. Click OK to close the dialog box.

9. You’ll want to make sure the user is prompted for the output GML file whenever the tool is run. In the tree view on the left, locate the GML output dataset, right-click the Destination GML v2 Dataset, and click Always Prompt.

10. Save your work and exit Workbench.

11. Double-click the tool in ArcToolbox. You will be prompted for a GML file to write in addition to the AutoCAD file that was previously being written.
12. Click the folder icon in the NESTS Input Layers field.

13. Double-click nests.mdb\NESTS.

14. In the OUTPUT AutoCAD File field, enter \output\nestout.dwg.

You have now completed the exercise ‘Modifying the custom export tool’.

By now, you will have a solid, basic understanding of the ArcGIS Data Interoperability extension:

- In Chapter 1, you used the direct read capability, which enables ArcGIS to directly read data in any supported format from the browse tree, or the more robust Interoperability connection. You demonstrated how useful this can be for previewing non-native data.

- In Chapter 2, you used Quick Import and Quick Export to demonstrate the translation capabilities of the Data Interoperability extension. You also saw how Quick Import and Quick Export can be used within the ModelBuilder environment.

- In Chapter 3, you saw the transformation abilities of Custom Interoperability tools, and how they can be integrated with both the direct read capability and the Quick Import and Quick Export tools. You used Workbench and some of its transformers to create custom formats.

You can use this knowledge as a stepping stone for developing practical applications suited to your own projects.

15. Click OK.

The Custom Data Export Tool appears, and displays processing information.

16. Click Close when processing is complete.
Appendix A

Getting started with Workbench

Workbench interface

Menu bar and toolbar

The pulldown menus on the top of the Workbench window contain commands that will affect the entire canvas; whereas individual command menus (displayed by right-clicking after selecting an object on the canvas) are applicable to separate components.

The toolbar gives you quick access to various commands. To separate individual tools from the main toolbar as shown below, grab the toolbar handle and drag it onto the canvas.
Tools for managing the layout

Hover your cursor over a tool to view a short description of its function. Layout tools allow you to:

- Automatically arrange the screen layout.
- Select more than one node and align the tops, bottoms, or right or left sides.
- Expand or collapse (show or hide) the attributes of all feature types.

Tools for enhancing the canvas

Hover your cursor over a tool to view a short description of its function. View, File, Edit, and Insert tools allow you to:

- Pan, zoom, and zoom to extents.
- Save, print, save to a mapping file, and run Workbench.
- Cut and paste, undo, and redo changes.
- Add source and destination datasets.
- Add a new feature type.
- Add a standalone comment. Right-click to associate it with a feature type or transformer.
- Specify a constant value to be assigned in the output data. (For example, you might always want a pen_color to be a specific number.)
- Insert a Visualizer transformer within the workspace (to start the Viewer).
Status bar
The area at the bottom, left side of the Workbench window displays progress information as well as short descriptions of selected menu items or tools.

Workbench elements
When Workbench is run, it reads the feature type attributes from the input data. It initially displays the same feature types and attributes for the output data. So you will often have something that looks like this:

Color definitions
The Properties button is on the top, right side of the transformer. It can appear in different colors, and it can display an exclamation point or an ellipsis.

In most cases, transformers contain default values that you can use when you run Workbench. However, if the Properties button is red and displays an exclamation point, then one of the fields is blank. You will have to enter a value before you can run Workbench.

If the Properties button is yellow and displays an ellipsis, the transformer is using default values that will work, but you have not yet confirmed that the default values are appropriate. To do this, click the Properties button, examine the values, make any changes, then click OK in the Edit dialog box.

If the Properties button is the background color and displays an ellipsis, you have already saved the value. If you still want to edit the value, click the Properties button to open the Edit dialog box.

Input arrow is red: A red arrow is a notification that there is no input for this port. If this is a feature port, no features are coming in; if this is an attribute port, no values have been set. This is not considered an error, since there are instances in which you might not want any input to a particular port.

Input arrow is green: The connection is properly matched.

Output arrow is yellow: You don’t have to connect the output, but its value will be lost when you run Workbench.

In general:
- Red arrows: Double-check to make sure any missing input is intentional.
- Green arrows: The connection is properly matched.
- Yellow arrows: The value being produced will be lost.
Quick changes

To **rename an attribute** without opening the Properties dialog box, select the attribute name, then click Rename from the command menu. You can also press F2.

**Create successive new attributes** by selecting the entire destination type and clicking Add Attribute from the command menu. Enter new names in the dialog box that appears, and tab through the fields to accept the default values and complete the entries.

When you click OK, the attributes appear on the Workbench canvas:

You can go back later and edit the attribute properties by selecting the attributes and clicking Properties from the command menu.

**Delete a connection** by clicking directly on the link and pressing Delete or right-clicking and clicking Delete on the command menu.

To choose more than one link, do one of the following:

- Hold down the Ctrl key and click each successive link.
- Hold down the left mouse button, drag the cursor in a rubberband around an area, release the mouse button, and press Delete.

**Inserting transformer connections**

This saves time if you already have many connections and want to insert a transformer between them.

- Drag a new transformer onto the canvas.
- Select the transformer; right-click; and from the command menu, click Insert Before.
- A wizard guides you through the connection settings.
- The new transformer appears on the canvas.
Inserting vertices on links
Select a connection; right-click; and from the command menu, click Insert Vertex on Link. This allows you to route your connections around other areas on the canvas.

Log
The log pane displays statistics and processing information that includes the following:

- Reader being used
- Writer being used
- Logging information
- Warning messages
- Software version

Information messages are displayed until the Workbench task is complete. From the log, you can search for text, copy selected contents of the window directly to another application, or save the contents to a text file.

Note: The text in this area contains important information on the translation. If you ever get results you did not expect in your output data, check the contents of the log.

Viewing Log Files
Open the ArcCatalog Tools > Options menu and click the Data Interoperability tab.

If the Write Log Files box is checked, log files will be saved in a default location. Click the View Logs button to open a file browser that displays the list of log files. You can view the log files with any text editor.